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2 CHAPTER

Note: Visit our website at www.blackbaud.com for the latest documentation and information.

Cash Receipts contains many standard reports to help you produce and view information you need quickly and
easily. Reports in Cash Receipts are valuable tools for monitoring, evaluating, and distributing information about
your payments and deposits.

This chapter explains the basics of reporting and includes a list of all reports available in Cash Receipts. In
addition, you will find explanations for the basic tools used in Reports, and tab functions. Reports Basics also
contains procedures for creating, printing, previewing, sending as e-mail, and exporting reports. Each report is
described in detail in the chapter for that report category. Pivot reports are discussed in the Pivot Reports Guide.

In Cash Receipts, reports are divided into categories:
¢ Bank Account Reports

¢ Deposit and Receipt Reports

e Pivot Reports

e Transaction Reports

Basic Reporting

The Reports page is the central location for reporting in Cash Receipts. From the navigation bar, select Reports to
access the Reports page. This page contains links to each report category. When you select a link, the program
displays a list of the reports making up the category.
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Accessing Reports

To select a report, select the link for the category of reports you need from the Reports page. For example, select
Deposit and Receipt Reports.

B the Financial Edge {5ample Data)

File Edit Yew Go Favorites Tools Help

4 Back # Forweard | Cornmunity Services Inc, * Cash Receipts - |

12 Reports » Deposit and Receipt Reports

B Casl ork Mew Open Delete.. Find.. Reports
Deposit 3 Bari
i Deposit Report Cash Receipts Report Account
‘® Query Reports
g [ame |Date Created |Created By ‘Prncess Tirne |Others IMay Modify o
uskom
...LE“ Export Reports
B Deposit and
Receipt
Reports
Pivok
Reports
(e e Transaction
g g3 Reports
Al
L7 Untagged
41 | E
I Dy show my reports
n & Cash Feceipts Repoit lists all cash receipts activity over a specified period of time.
|Welmme o Cash Receipts | 4

On the Deposit and Receipts Reports page, select Cash Receipts Report from the list on the left. If any cash
receipts reports have been saved, they appear on the right of the screen. You can either open one of the saved
reports or create a new report. To open a saved report, select the report type and then double-click the report in
the frame on the right. For more information about creating a cash receipts report, see the Deposit and Receipt
Reports chapter.

Manage Tags

The Manage Tags feature allows you to better organize and filter your Financial Edge report parameters. For
example, you can filter all of your saved report parameters by tags and categories, such as “Reconciliation” or
“Fiscal Year 2012.” When you mark the checkbox to show a tag or category on a reports page, only the report
parameters with that specific tag and category display.

To create and manage report parameter tags, simply select Manage Tags below the list of reports on any Reports
page. You can create as many categories and tags as you need, and when necessary, mark tags inactive.

To tag a report parameter, simply right-click an existing parameter and select Tags from the menu. Every
category and tag you have created in that module appear on the list.
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» Manage report tags

From Reports, select Manage Tags. The Manage Tags screen appears. From here, you can add new tags

and categories, or edit and delete existing tags and categories. You can also use the arrows in the top right
corner of the screen to move items up or down in the list.

48 New Edt 7 Delete

-Year
2012

- Purpose
Auditars
Recaonciliation

EHsave | Cancel |

2. Select New to add a new tag and category. The Add Tag screen appears.

LCateqgony: ||
Tag |
[V Active
[E save | Cancel |

Enter a report category and name for the tag. If you want the tag to be active, mark the checkbox.
4. Select Save. You return to the Manage Tags screen.

You can also edit and delete tags, as well as organize your list of categories and tags. You can change the
name or delete categories and tags at any time.

6. Once you have made your changes, select Save.
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» Tag areport parameter

1. To tag a report parameter, simply right-click an existing parameter and select Tags from the menu. Every
active category and tag you have created in that module appear in the menu list.

€ The Financial Edge {Sample Data) [_ O] x

File Edit Vew Go Favorites Tools Help

4 Back # Forward | Community Services Inc. * General Leclger '|

@ Reports+Journal and Batch Reports

E Batch Det: : Mew Oper Delete.. Find | Reports |
(3 Batch Summany Feport 7 Account
EEEOS LR e Batch Retail Report Reports
R Batch & R
1 PEUTING Baten SUMMEWRER |y me ‘Date Created |Crsated Ey ‘Prucsss Time |Others May Modiry | Allocation
j Tranzaction Journal Reports
‘ Tags ‘ ‘ear 2013 Budget
o Reparts
1 Mew Batch Detail Report PUrpose " 201z B
L R Custam
L5 Open Manage Tags 4F MewTag Reparts ‘
X Delete... Financial
Save As... Statements
Manage Tags. a‘h} Rename... GASE 34
_— 7 Repotts
|_7 All =% Print Grant
L =
: ~ lagged Wl Preview Reports
Yeal r,
ﬁ Export Journal and
send as Mail gaetcgrts
Purpose E ? L
-V Auditors Pivot
|7 Reconciliation & Eind... Qrl+F Reootts
@ Export Batch Detail Report List Grid.. . :ro]ectt
eports
Export Batch Detail Report List Grid to Excel... s
Columns, ..
[+ Properties

Prrog LI
I~ Only show my reports

The Batch Detail Report provides detailed information about selected batches and the
tiansactions within those batches

|\Nelc0me to General Ledger |

RS

2. Select the category and tag. You return to the Reports page.

Report Tabs

Whether you create a new report or open a saved report in Cash Receipts, a screen appears with tabs to specify
how the report should look and the information included in the report. Like folders in a filing cabinet, these tabs
help you select information to appear on a report. For example, the Cash Receipts Report includes the General,

Filters, and Format tabs. To navigate among a report’s tabs, select the tab itself or use Back and Next. Once you
learn to run one report, it is easy to run other reports because many of the tabs have similar features.

Reports in each category have common tabs with similar selections. Remember that records must satisfy all
parameter settings you select for the report before they are included in the report. For example, if you mark
Include inactive accounts on the General tab, this does not mean all inactive accounts in the database appear on
the report. A selected date range or a filter can eliminate some accounts. For more information about tabs, see
that report in its respective chapter.

Note: Keep in mind that options, fields, and other selections vary from report to report.

Following are pictures of each tab in Cash Receipts Reports. Keep in mind that options, fields, and other
selections vary from report to report.
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General Tab. On the General tab, you set parameters specific to the report you have open. You can make
selections for the format and information in the report. All Cash Receipts reports use the General tab.

lE Mew Cash Receipts Report I
Fil= Edit “iew Fawortes Tools Help

G E R0 =2 |

|2: Filtersl 3 Folmatl

Include hanzactions with theze dates

Deposit date: IIncIude dldates 7]
Receipt date: IIncIude all dates j
Entered on date: IIncIude all dates 7]
Include depasit numbers from: | @ To: | 4|
Inelude receipt numbers from: | ﬁl To: I ﬁl

[~ Show mizcellaneous payment details
Include deposits from

¥ Accounts Receivable
¥ Cash Receipts

[~ Create an output quemny of IDeposits "I
Fieport arientation: IF'ortrait 'l

< Back | Hext > | Cancel | Frrint Preview Layout

Glossary: A filter is criteria records must meet to be included in a report. For example, if you apply the Account
filter, only the accounts you select are included in the report.

Filters Tab. On the Filters tab, you include records based on selected criteria such as Clients, Deposits, Banks, or
Payments. For example, you want to run a cash receipts report and include payments made during the month
of July. You can filter the report so that only payments whose payment dates fall within the month of July
appear on the report. Payments received in any other month do not appear on the report. All Cash Receipts
reports use the Filters tab except the Bank Register Report, which uses the Filters button found on the
General tab. For information about filters for a specific report, see that report in its respective chapter.
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For each filter listed in the Filters column, specify whether to include all or selected records. When you do not
want to filter records from the report using criteria listed in the Filters column, select All in the Include
column. For example, for a report to list all payments, regardless of payment date, select All in the Include
column for Payments. When you select All, <All Payments> appears in the Selected Filters column. For more
information about filtering criteria, see the Program Basics Guide.

lg Mew Caszh Receipts Report I
File Edit “iew Fawortes Toolz Help
Sl el |
Filkers I Include Selected Filters

Clients all <Al Clients=

Client Attributes all <Al Client Attributes

Barks all <Al Banks=

Deposits all <Al Deposits=

Payments all <Al Payments =

< Back | Hest > | Caticel | Erint | Freview | Lapout |

Format Tab. On the Format tab, you designate the format of the report. Your settings on this tab determine the
appearance of the report. You can create headings, page footers, and report footers. You can select details
and the criteria used to create the report and include the criteria list with the report. On some reports you can
sort or break the report according to selections you make. You can select the format for displaying monetary
amounts and select colors for the report. All Cash Receipts reports use the Format tab.

The list on the left of the screen displays formatting options for the report: Headings, Criteria, Detail, Grand
Totals, Sort/Break, Page Footer, Report Footer, Miscellaneous, and Color Scheme. When you select an item
in the list, the right side of the screen changes to present selections for that section of the report.
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For example, in a deposit report, select Detail and a grid appears with several optional details you can add to
the report. For additional payment detail, mark Show payment details for these payment methods and mark
the payment method checkboxes. You can also mark Separate page for each payment method to show
payment information for each selected payment method on its own page. For information about formatting a
specific report, read about the report in its respective chapter.

I New Deposit Report I
File Edit “iew Fawortes Toolz Help

I = el |

1 Generall 2: Filkers ~ 3: Format |

Headings Detail

Criteria

B Detai v Show papment detail for these papment methods:

Sor
Page Facter [ Check

¥ Cash
Report Footer .
Miscelaneous ||; Erueglt card
Lalar Scherme ¥ Recsived EFT
¥ Other

Doty

Upl
Do |

[~ Separate page for each payment method
[" Separate page for each deposit

< Back [dEnt s Caticel Erint Freview Lapout

Report Categories

Cash Receipts includes many standard reports to help you quickly and easily produce and view information you

need. These reports give you information to help you stay up-to-date with every aspect of your organization. To
help you locate the report you need quickly, reports are divided into categories: Bank Account Reports, Deposit
and Receipt Reports, Pivot Reports, and Transaction Reports. For more information about a specific report, see

that report in its respective chapter.

Bank Account Reports

¢ Bank Profile Report

¢ Bank Reconciliation Report

¢ Bank Register Report

Deposit and Receipt Reports

e Cash Receipts Report

e Deposit List

e Deposit Report
Note: Pivot reports are available in The Financial Edge only if you have Microsoft Excel 2000 or Excel XP
installed on your computer.

Pivot Reports
Transaction Reports
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¢ Account Distribution Report
¢ Project Distribution Report

Reporting Procedures

You can use a variety of parameters to define the output for reports in Cash Receipts. Saving these parameters
also makes future reporting easier. The following procedures provide instructions for creating, printing,
previewing, sending as email and exporting reports. While these procedures are written specifically for a Cash
Receipts report, you can use these same basic steps as a model for all reporting in Cash Receipts. For specific
information about tabs, fields, options, and checkboxes for a particular report, see the chapter for that category
of reports.

Creating a report

Creating a report is a quick and easy process. For this procedure we create a Cash Receipts report.

» Creating a Cash Receipts report

1. From the Reports page, click Deposit and Receipt Reports. The Deposit and Receipt Reports page appears
with a list of all Deposit and Receipt reports on the left.

2. Inthe list on the left, select Cash Receipts Report.

Eile Edit View Go Favorites Tools Help

4 Dack % Forward | Community Services Inc, * Cash Receipts '|

\@ Reports - Deposit and Receipt Reports

B Casl epart New Open Delete.. Find
Deq s
Deposit Report Cash Receipts Report

Name |DatE Created |Creatad By |Prucess Time: |0ther5 May Modif

Manage Tage...

AN
L]~ Untagged

L4 | /]

[~ Only show my reports
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3.

On the action bar, click New. The New Cash Receipts Report screen appears on the General tab.

l@ Mew Cash Receipts Report I
Eile Edit “iew Favortez Tools Help

RS R0 2 |

Filters | 2 Format |

Include transactions with these dates

Deposit date: Ilnclude all dates ‘I
Receipt date: Ilnclude all dates ‘I
Entered on date: Ilnclude all dates ‘I

Include depogit numbers from; | ﬂ T |
Include receipt numbers from: | H| To |

2] 2

[~ Show mizcellaneous papment details
Include deposits from

W fccount: Receivable
¥ Cash Receipts

[~ Create an output query of IDeposits 'I
Freport arientation: IPortrait 'I

< Bach | Mext = | Cancel | Print Freview Layout

Note: Fields, options, and checkboxes on the General tab vary for each report. For General tab selections on a
particular report, see the chapter for that category of reports.

4.

10.

In the Deposit Date field, select a date or date range for deposit dates to include in the report.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the
start date until present is included. If you leave both fields blank, all activity is included.

In the Receipt Date field, select a date or date range for receipts dates to include in the report.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the
start date until present is included. If you leave both fields blank, all activity is included.

In the Entered on date field, select a date or date range for which deposits were entered into the
program.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field
blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the
start date until present is included. If you leave both fields blank, all activity is included.

In Include deposit numbers from [ ] to [ ] and Include receipt numbers from [ ] to [ ], you can enter or
select a range of deposit numbers or receipt numbers to include in the report. If you leave both fields
blank, the report includes all deposit or receipt numbers.

Mark Show miscellaneous payment details to separate payments into separate lines for Accounts
Receivable and Cash Receipts components. This option appears only if you have Accounts Receivable
installed.

Mark the checkbox for each accounts receivable program whose deposits you want to include in the
report. The options appearing depend on the accounts receivable programs you have installed.

Mark Create an output query of deposits to create a query of deposits that appear in the report. This
query is available for use in other areas of the program.
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11. Inthe Report orientation field, select “Portrait” for the report to appear vertically or “Landscape” for the
report to appear horizontally.

Ig Mew Caszh Receipts Report I
File Edit “iew Favortes Tools Help

=R R e |

1: General |2: Filters | K3 Formatl

Include tranzactions with these dates

Deposit date: IMonth to date vl 02/01/2003 ta 0241142003
Receipt date: IMonth to date vl 02/01/2003 ta 0241142003
Entered on date: IMonth to date vl 02/01/2003 to 02417142003

Include deposit numbers from; | ﬂl T |
Include receipt numbers from: | ] To |

2] &

W Show miscellaneous payment details

Include deposits from
W Account: Receivable
¥ Cash Receipts

[~ Create an output query of IDeposits 'I
Freport arientation: IPortrait 'I

< Bach | Mext = | Cancel | Print Freview Layout

12. Click Next or select the Filters tab.

Ig Mew Caszh Receipts Report I
File Edit “iew Favortes Tools Help

=R R e |

1: General

(%]

: Format |

Filters I Include I Selected Filkers
Clients all <Al Clients =
Client Attributes all <Al Client Attribukes =
Banks all <Al Banks>
Deposits all <All Deposits =
Payments Al <All Payments =

< Back | Mext = Cancel Print Freview Layout
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13. Inthe Include column for the Banks filter, choose “Selected”. The Selected Banks screen appears.

Banks I
[ I Description [ Dezcription
Operating Operating Account
Fayroll Fayroll Account
SB & AR Student Eilling & Accounts Receivable
>
pd
<
<
Ok I Cancel |

14. Double-click the bank account to include in the report. The selected bank account moves from the left
box to the right Banks box.

Banks

Banks

Ok I Cancel
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15. Click OK. You return to the Filters tab. The selected bank account appears in the Selected Filters column

on the Banks row.

Ig Mew Caszh Receipts Report
File Edit “iew Favortes Tools Help
S RE R el
1: General 2 Filters |§: Formatl
Filters I Include I Selected Filkers
Clients all <Al Clients =
Client Attributes all <Al Client Attribukes =
Banks Selected ﬁl
Deposits all <All Deposits =
Payments Al <All Payments =
< Back | Mext = | Cancel | Print | Freview | Layout |

16. Click Next or select the Format tab. The Format tab appears. On the Format tab, the right side of the

screen changes as you make selections in the list on the left.

17. From the list, select Headings. The program assigns a name in the Title field based on the record type; in

this case, “Cash Receipts Report”. You can change this title.
18. In the Subtitle field, enter subtitle for the report.

Ig Mew Caszh Receipts Report

File Edit “iew Favortes Tools Help

= IERERE = ey

]|

?- |

1 Generall 2 Filter:

Criteria

Detail

Grand Totals
Sort/Break.
Page Footer
Report Footer
Miscellaneous
Color Scheme

—Heading Format

Title: ICash Receiptz Report
Subtitle: ISB & AR account

Aligr; I Center - I

[V Print arganization name in header

— ¥ Print Page Mumber in Heading ¥ Frit Bepaort Date in Heading

Format: IF'age 1 j Format: IShort Date and Time j
Aligr: [Right = || e [Let i
[V Frint report heading on each page
< Back | et Cancel Print Freview Layout
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Note: If you have the appropriate security rights, you can use credit card, bank account, and Social Security
numbers to sort report data and to identify records included in the report. The Sort by option is hidden for any

user without these rights. For more information, see the Security chapter of the Administration Guide for The
Financial Edge.

19. You can select other formatting options from the list on the left. For example, select Detail.

20. To show distribution by account and project characteristics, mark Show distribution for these
characteristics and the checkboxes for the characteristics. You can also select to show a characteristic as a

separate column in the report, show the transaction total, and show receivables information for a
distribution.

21. To add additional summary reports to the end of the main report, mark Include summary report for and
mark the checkboxes for each item on which to report.

Ig Mew Cazh Receipts Report I

File Edit “iew Favontes Tools Help
== R e |

1 Generall 2 Filters 3 Format I

Headings Detail
Criteria

¥ Show distribution for these characteristics

Grand Totals ™ Account ID -

Sart/Break ] Account D escription

FPage Footer u
Report Footer [T Project Description _p
Miscellaneous [T Class ;I Dian

Color Scheme ¥ Shaw charactenistics az a column in the main report body

™ Shiow tranzaction bokal
™| Ghovreseiyabies /bl ane it distituticn

¥ Include suramary repart for

™ Source
[T System
[ Bank Account 4|
¢ Back | Ii [ Cancel Print | Freview Layout

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.
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22. Click Preview to preview the report on the screen. A message appears indicating the program is
processing the report. If you marked the option to create an output query, the Save Static Query screen
appears.

lQ Mew Cash Receipts Report

X 44 dadtle > M [ZEFE [ Z] [ |4 Tods 1oz

Preview

DT 16T A Community Services Inc.
Cash Receipts Report
SEB & AR account

Fsguiwt  Duperit
Dusorivtie . Humber  Humber  Dah Senma Bvvim o nnt P juct D

et 1 1 TLATAWS  Vendingmashi CE i 5000 1001

Doy tination. D cxiptiv .

His. Cask Eacegh tuet

Trgal 1 WA Az T L A pplisarion Fune 6250 Mo Paojucr

Fordnl 1 ML Apglisstivn Fa CR hpglication Fuss $6230 <Ho Pmjuct

Doy tination. Dassription. Aot

Mic. €ash Bacogpn Forfal 312500

Foom campw phomac 1 MAANE  Payphommw 0k Payphons m e 15500 1001

Frem campw phenud 1 WL21200%  Payplenamw CE Payphezs miszm SIS0 <Ho Puojeat

Dy tination Durcziption Amo wut

Mic. tah Bncogn Fiom campw phonse #1000

Luraziption 1 A1 Prsnp matrz GR parmants #2330 10m

dusczipion 1 081005 e manrz CR puymanrse 330 +Ho Pujucr

D oziptiv . Ao wut

duscription £330

2T SHII0 M Prjuct

e finatinn s arininm, fomamn

23. Inthe Query name field, the program assigns a name for the query. You can use this name or enter a new
name. Enter a description of the query in the Description field, and click Save.

Note: You can set an option to maximize the preview window when you preview a report. To do this select
Tools, Options and mark Automatically maximize preview window.
24. The New Cash Receipts Report preview screen appears so you can preview the report.

25. When you are finished viewing the report, click the red X to close the preview window. You return to the
New Cash Receipts Reports screen.

26. Click Save on the action bar to save the new report. The Save Report as screen appears.

Save Report as I

Fepart nanie: I

Drescription:

¥ Others can un this report

[ DOthers can modify this report

H 5ave | Cancel |

27. Inthe Report name field, enter a name for the report and enter a description in the Description field.
Mark the checkboxes to allow others to run or modify the report.

Note: You can set an option to save selections made on report tabs when you close. To do this, select Tools,
Options and mark Automatically save report parameters on close.

28. Click Save to save the report. You return to the Cash Receipts Reports screen.

29. Close the screen. You return to the Cash Receipts Reports page, and the new cash receipts report appears
in the grid.
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Printing a report

You can print a hard copy of a saved cash receipts report without opening the report. Your selections on the
Format tab of the report determine the information that prints on the report and how this information is
formatted. For this procedure, we print a cash receipts report.

» Printing a Cash Receipts report

1. From the Reports page, click Deposit and Receipt Reports. The Deposit and Receipt Reports page
appears. A list of all deposit and receipt reports appears on the left of the page.

2. Inthe list on the left, select Cash Receipts Report. A list of saved cash receipts reports appears in the grid
on the right.

Note: You can set an option to print the report using the orientation defined in Print Setup. To do this, select
Tools, Options and mark As defined in Print Setup. For example, if a report is designed to print in portrait, but
the print setup is set for landscape, the report prints the report in landscape.

3. Select from the list the report to print.

Eile Edt Yiew Go Favorites Tools Help

# Back = Forward | Community Services Inc. * Cash Receipts '|

12 Reports + Deposit and Receipt Reports

B Ca: eport MNew Open Delete.. Find..

Dep =
Deposit Report Cash Receipts Report

Mame |Data Created |Creat5d By |Pmcess Time |0thar5 May Madif

Manage Tags.

I an
LJ” Untagged

KIS 1

[~ Only show my reports

Note: You can set an option to print the report using the orientation defined for the report. To do this, select
Tools, Options and mark As defined for the Report. The report prints in the orientation selected on the report
regardless of what is defined in Print Setup.

4. From the menu bar, select File, Print. A message appears indicating the report is printing. After the report
prints, you return to the Deposit and Receipt Reports page.

Previewing a report

You can preview the format and information in a report without opening the report. We recommend previewing
a report before printing or sending it to another person. By previewing, you can make sure you included the
required information and that the report is formatted as you want it. For this procedure, we preview a cash
receipts report.
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» Previewing a Cash Receipts report

1. From the Reports page, click Deposit and Receipt Reports. The Deposit and Receipt Reports page
appears. A list of all deposit and receipt reports appears on the left of the page.

2. Inthe list on the left, select Cash Receipts Report. A list of saved cash receipts reports appears in a grid on
the right.

3. Select from the list the report to preview.

PE The Financial Edge {Sample Data)

Eile Edit View Go Favorites Tools Help

4 Dack % Forward | Community Services Inc, * Cash Receipts '|

\@ Reports - Deposit and Receipt Reports

B Ca Epol New Open Delete.. Find..

Deposit List >

Deposit Report Cash Receipts Report
Name |Dats Created |Creatad By |Prucess Time: |Othsrs May Modif

Manage Tags...

I Al

LJ” Untagged

LI I
[~ Only show my reports

Note: You can set an option to maximize the preview window when you preview a report. To do this select
Tools, Options and mark Automatically maximize preview window.

4. From the menu bar, select File, Preview.
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5. A message appears indicating the program is processing the report. The <Cash Receipts Report> preview
screen appears.

lQ February receipts and deposits
X 44 dodte > M [ZEFE [ ][ |4 Tods 1oz

Preview

Community Services Inc.
Cash Receipts Report

Dogorit
:  Hambuer  Dan oo yer oo

1 0142003 T3 VNI $30.0
0112003 tion Fooe icatien. oo 125 10

o112 Poihm muhamer CE T $3100

1
1 L2003 Payphons mwnn R » - 31000
1
H

v2ATR003 Vindinmachine AR 341 0

S 00

6. When you are finished previewing the report, click the red X to close the screen. You return to the Cash
Receipts Reports page.

Exporting a report

To use report information in another software application, for example, Microsoft Excel or Crystal Reports, you
can export the report. When you export a report, you send report information from the database to another
software application using a data file. You can export a report without opening the report. For this procedure, we
focus on exporting a cash receipts report in Excel format (*.xls) to a disk file.

» Exporting a Cash Receipts report

1. From the Reports page, click Deposit and Receipt Reports. The Deposit and Receipt Reports page
appears. A list of all deposit and receipt reports appears on the left of the page.

2. Inthe list on the left, select Cash Receipts Report. A list of saved cash receipts reports appears in a grid on
the right.
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3. Inthe grid, select the report to export.

E The Financial Edge (Sample Data)

File Edit vView Go Favorites Tools Help

% Bark # Forward | Cammunity Services Inc, * Cash Receipts '| E

12 Reports « Deposit and Receipt Reports

BCa eipts Repart New Open Delete.. Find

Deposit List 5

Deposit Report Cash Receipts Report
Mame |Date Created |Created By |Process Time |0thers May Madif

Manage Tags...

I Al

L]~ Untagged
KN I
[~ Only show my reports

4. From the menu bar, select File, Export. A message appears indicating the program is processing the
report. If you marked the option to create an output query, the Save Static Query screen appears.

Save Static Query [ x| I

Query name: |[HE

Diescription: ;I Cancel |

=
Query format: I Static vl Created Fram: Reparts - Februam receipts
and deposits

v Others can wn this query
[+ Others can modify this querny

5. You can save a new, updated query based on the filters and settings in the report or you can click Cancel
to continue the export process without creating a static query. If you click Cancel, the Export screen
appears. Skip to step 7.

6. To create a query, in the Query name field, use the name assigned by the program or enter a new name
for the query. Enter a description of the query in the Description field, and click Save. The Export screen
appears.

In the Format field, select “Excel 5.0 (XLS)”".
In the Destination field, select “Disk file”.

Epor |
Eormat;
— _DK
[Excel 5.0[<L5) =l
o Cancel |
Destination:

9. Click OK.
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10. The Choose Export File screen appears. The program assigns a name in the File name field based on
report type and system information. You can change this name.

Choose Export File B I
Save in Ia E=part files j . IE:F -

File name: IUSBI1_2EBESD1 BE_BBRepE0.=lz j Save I
Save as twpe: IEHCB' 5.0 Hls) j Carcel |

Z

11. Click Save. A message appears indicating the program is exporting the data. Once the data has been
exported to your file, you return to the Cash Receipts Reports page.

Sending a report as e-mail

In Cash Receipts, you can share report information with other users through electronic mail. You can send the
results of a report to another user for further analysis or to use in other applications. When you send report
information through e-mail, you perform two functions: changing the format of the information to a data file and
sending this data file to another person. Before you can send a report to another user, you must first select a
format (such as Microsoft Excel, Crystal Reports, or Adobe Acrobat) for the data file. The format determines the
appearance of the report and the software applications in which you can open the data file. Sending report
results by e-mail can be particularly useful when an individual needs to quickly reference report results but does
not need to access or edit the report.

You can send report information by e-mail without opening the report. For this procedure we focus on sending a
cash receipts report.
» Sending a Cash Receipts report as email

1. From the Reports page, click Deposit and Receipt Reports. The Deposit and Receipt Reports page
appears. A list of all deposit and receipt reports appears on the left of the page.

2. Inthe list on the left, select Cash Receipts Report. A list of saved cash receipts reports appears in a grid on
the right.
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3. Inthe grid, select the report to send as mail.

E The Financial Edge (Sample Data)

File Edit vView Go Favorites Tools Help

% Bark # Forward | Cammunity Services Inc, * Cash Receipts '|

12 Reports « Deposit and Receipt Reports
B ale Mew Open Delete . Find
Deposit List 5
Deposit Report Cash Receipts Report
Mame |Date Created |Created By |Process Time |0thers May Madif
Manage Tags...
I Al
L]~ Untagged
KN I
[~ Only show my reports

4. From the menu bar, select File, Send as Mail. A message appears indicating the program is processing the
report. If you marked the option to create an output query, the Save Static Query screen appears.

Save Static Query [ x| I

Query name: |[HE

Diescription:
=
Query format: I Static vl Created Fram: Reparts - Februam receipts
and deposits

v Others can wn this query
[+ Others can modify this querny

5. You can save a new, updated query based on the filters and settings in the report or you can click Cancel
to continue the export process without creating a static query. If you click Cancel, the Export screen
appears. Skip to step 7.

6. To create a query, in the Query name field, use the name assigned by the program or enter a new name
for the query. Enter a description of the query in the Description field, and click Save. The Export screen
appears.

In the Format field, select “Excel 5.0 (XLS)”".
In the Destination field, select “Microsoft Mail (MAPI)”.

|
Format:

Canhicel |

Destination:

| Microsaft Mail [M&PI) =l

9. Click OK. The Send Mail screen appears.
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10. Inthe To field, enter an email address. For example, enter “cjones@internet.com”.

11. In the Subject field, enter a subject for the message.

12. In the Message box, enter a message to the recipient. For example, “Here is the cash receipts report you
requested.”
Send Mail ]|
’T‘ Check, Mames | Address | Cancel |
Tor Iciones@intemet.com
Ce: I

Subject: |Cash Receipts Report Feb, 2003

Meszage

Here iz the cazh receipts report you requested, ;I

[

13. Click Send. The report is sent an attachment to your email message. You return to the Cash Receipts
Reports page.
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Reporting categories in Cash Receipts include Bank Account Reports, Deposit and Receipt Reports, Pivot Reports,
and Transaction Reports. This chapter discusses Bank Account Reports. For information about other report
categories, see the chapter for that category.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about bank account reports in Cash Receipts. Hands-on experience is
the best way to learn, so we encourage you to try various options with your sample database.

Bank Account Reports in Cash Receipts include:
¢ Bank Profile Report

¢ Bank Reconciliation Report

¢ Bank Register Report

Bank Profile Report

The Bank Profile Report presents a profile for a designated bank. It provides basic bank account information
including account number, routing number, and address information. This report shows the total debits and
credits associated with each account. Adjustment transactions can also be included to further facilitate the
reconciliation process.

The Bank Profile Report has three tabs on which you set parameters: General tab, Filters tab, and Format tab. To
move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these
tabs you specify the records to include in the report and how the report should look. For more information about
creating a Bank Profile Report, see “Creating a Cash Receipts report” on page 9.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize the output results of your report.
For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s
results.
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On the General tab, you set parameters specific to the report you have open and make selections about the

information included in the report.

n Hew Bank Profile Report

Fil=e Edit “iew Favartes Tools
H &&= F

l 2 Filtersl 3 Format

Include this infarmation:

Help
? =

v Cazh account infarmation

W Paprient infarmiation

¥ Regizter ending balance

v Summary by transaction twpe
W Summary By Blackbaud system
W Summary by post status

Include tranzactions with these dates

[

Tranzaction date; |Include all dates

Report orientation: |Landscape =

=

| MHewt » | Cancel |

Prrint | F'reviem‘ Layout |

Include this information: Mark the checkboxes in this box to select bank information to include in the report.
Some options are available only if you have the optional module Cash Management.

Transaction date. In the Transaction date field, select a date or date range for the transactions to include in

the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a

sample layout of the report without data.

Report orientation. Select Portrait for the report to appear vertically or Landscape for the report to appear

horizontally.

Filters Tab

Glossary: A filter is criteria records must meet to be included in a report. For example, if you apply the Banks
filter, only the banks you select are included in the report.
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On the Filters tab, you can filter the bank accounts appearing in the report. For more information about
filtering in The Financial Edge, see the Program Basics Guide.

I3 Mew Bank Profile Report I
Fil=e Edit “iew Favortes Toolz Help
RS W -2 |

1 General § | 3 Format |

f®0pen ) Clear Al Filters

Filkars I Include Selected Filkers
Banks all <Al Banks
< Back | Hemt » | Cancel | Print | Preview | Layout |

Open. Once you highlight a filter in the grid, click Open to access the Selected <Filter> screen on which you
select specific filters.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the available filters for this report. You cannot edit this column.

Include. In the Include column, if you choose Selected, the Selected <Filter> screen appears for you to designate
specific filters.

Selected Filters. After you have selected specific filters, they appear in the Selected Filters column.
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Selected Filters Screen

If you click Open or choose Selected in the Include column, the Selected Banks screen appears with additional
fields and options.

Selected Banks Ed I

| Erzvionz Filier  Elesr Filizr -

Include these banks:

1D I Description

F'a_l,lmll Fayrall .t'-‘«c:nunt
5B & AR Student Billing % Accounts Receivable

Al [¥lv

] I Cancel |

Include. You can include all or selected bank accounts. Bank accounts list in the box below.

Find. You can enter all or part of the account ID or description in the Find field to quickly locate bank accounts
without scrolling through the list.

ID. The ID column lists bank account ID’s.
Description. The Description column lists bank account descriptions.

Include these banks. To select a bank to include in the report, highlight the bank from the box on the right
and click the single right arrow button. The bank name appears in the Include these banks box.

Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option is
provided.

Note: The heading defaults to Bank Profile Report in the Title field. You can leave this as the title for the report
or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how you want the heading aligned and whether

you want your organization’s name to appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

A% New Bank Profile Report I
File  Edt “iew Fawaortes Toolz Help
FlER = |
1: General | 2 Filkers
E Heading: Headings
Criteria 5
Soit — Heading Format
Page Footer Title: |Bank Prafile Feport
Rieport Foter Subtite: |
Miscellaneous
Align: IEentel 'I
[¥ Print organization narne in header
W Print Page Number in Heading ¥ Print Report Date in Heading
Format: IF'age 1 j Format: I Short Date and Time j
Align: [Right =] | A JLet =]

¥ Print report heading on each page

< Back | L= Cancel Print Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.

A% New Bank Profile Report I
File  Edt “iew Fawaortes Toolz Help

RS ]2
1 Generall 2 Filters ~ 3: Farmat |

¥ Print these criteria on Ia separate page "I

Headings
‘B Criteria

Sort

Page Footer
Fieport Footer
Miscellaneous

Saved report name
Tranzaction dates to include
Banksz to include

Print | F'leviegl Layout |

< Back | L= | Cancel |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by

column and select Ascending or Descending in the Order by column.
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If you make no selections in the Sort by column in the grid, the program sorts by deposit number in ascending
order.

n Mew Bank Profile Report
Fil= Edit “iew Fawortes Tools Help

EH <=2 -

1 Genelal] 2: Filters ~ 3: Farmat l

=] Headings Sort
5] Criteria
Sart by | Order by |
=] Page Faoter Bark ID Ascending
2] Report Footer

2] Mizcellaneous

[ Page break on each new Bank [D

< Back | Cancel

Frrint | Preview | Layout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

u New Bank Profile Report
File Edit Wiew Favorites Tools Help
u _1 % —a mJ ? .

1 Genelal] 2 Filterz  3: Format l

=] Headings Page Footer

=] Criteria

E Sart FPage Footer Text

Page Foater Teut:
2] Report Footer
=] Miscellaneous
[ Print Page Mumber in Footer [~ Print Report D ate in Footer
< Back | | Cancel Print Preview Layout
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Report Footer. You can enter a maximum of 254 characters in the report footer and select how you want text

aligned. The report footer appears at the end of the report.

n Mew Bank Profile Report
Fil= Edit “iew Fawortes Tools Help

EH <=2 -

1 Genelal] 2: Filters ~ 3: Farmat l

5] Headings Report Footer

] Criteria

EET Fieport Footer T ext

5] Page Footer Test:

2] Mizcellaneous

< Back | | Cancel | Frrint | Preview | Layout |

Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the report and the font size

for the report.

n Mew Bank Profile Report
File Edt Yiew Faworites Toolz Help
u _5- é —a mJ ? -
1 General] 2: Filkers ~ 3: Format l
2] Headings Miscellaneous
2] Criteria
=] Sort Shaw cunency character on All amounts
2] Page Footer Show percent sign on &l amaounts
=| HDD“ Footer Megative amaunt farmat [1234.56)
e Wurnber of digits after decimal for amonts 2
Murmber of digits after decimal for percentages 2
Show 1000 separator ez
Show blanks instead of zeros Mo
Fant gize 8
Sample amaunt:
Amaurt [$1.234.5E)
Percent 100.00%
< Back | | Cancel Brint Freview Lapout




32 CHAPTER

Bank Reconciliation Report

The Bank Reconciliation Report presents the adjusted statement balance, or the ending statement balance plus
deposits in transit less outstanding disbursements. In addition, this report lists all transactions included in the
reconciliation process and all adjustments (such as fees, interest earned, voided checks) recorded in the register
at the date of reconciliation. You can run the Bank Reconciliation Report from Reports and from Banks.

The Bank Reconciliation Report is made up of three parts: Reconciliation of Register to Statement, Outstanding
Transaction Details, and Reconciliation of Cash Accounts to Statement. With Reconciliation of Cash Accounts to
Statement, you can identify timing discrepancies and outstanding transactions in cash accounts affecting the cash
balance, but not accounted for in the period reconciliation.

The Bank Reconciliation Report provides a way of trouble-shooting issues before you receive your bank
statement. From this report, you can print reconciliations from previous months, or a pre-reconciliation. With the
pre-reconciliation report, you can print a computer balance of the current account without actually reconciling
the account. This is similar to the transaction register you use to manually balance a personal checking account
until your bank account statement arrives.

The Bank Reconciliation Report has two tabs on which you set parameters: the General tab and Format tabs. To

move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these
tabs you specify the records to include in the report and how the report should look. For more information about
creating a Bank Reconciliation Report, see “Creating a Cash Receipts report” on page 9.

General Tab

On the General tab, you set parameters specific to the report you have open and make selections about the
information included in the report.

IQ Hew Bank Reconciliation Report I

File Edt “iew Favontes Toolz Help
SR E A= |

1. General |2: Formatl

Bank account: IDperating j IDperating Account

Print; ILast completed reconciliation j

Beginring balance: |$IJ.EID
Reconciliation date: IIJei.-’1 942002
Ending balance: |$IJ.EID

Show unreconciled transactions with these dates -

Trarsaction date: |<S|:|ecific ranger | [Stark date: I El End date: IDdﬂ /2002 m]
Fiepart orientatian: IF'mtrait 'I

< Hark | Heut » | Cancel | Print | Preview | Layout |

Bank account. In the Bank account field, select the bank account to be included in the report.
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Note: When creating a pre-reconciliation report in Banks, use the statement date from the Bank Account
Reconciliation screen for the Reconciliation date field. In Reports, use one month from the last reconciliation
date.

Print. In the Print field, select “Last completed reconciliation,” “Reconciliation using this information,” or
“Historical Reconciliation.” To review the most recent reconciliation, select Last completed reconciliation. To
create a pre-reconciliation report, select Reconciliation using this information. When you select this option,
you must enter information in additional fields.

If you select “Historical Reconciliation,” a drop-down menu appears and you can choose a historical
reconciliation from the list.

Beginning balance. The Beginning balance field is enabled only if you select Reconciliation using this
information in the Print field and the account has not been reconciled before. After you reconcile once, the
ending balance from the most recent reconciliation appears in the Beginning balance field and cannot be
edited.

Reconciliation date. The Reconciliation date field is enabled only if you select Reconciliation using this
information in the Print field. Enter the date of reconciliation.

Note: For a pre-reconciliation report, use the ending balance from the Bank Account Reconciliation screen in
Banks in the Ending balance field.

Ending balance. The Ending balance field is enabled only if you select Reconciliation using this information in
the Print field. Enter the ending balance in this field.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

Show unreconciled transactions with these dates. In the Transaction date field of the Show
unreconciled transactions with these dates frame, select a date or date range for unreconciled transactions
to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

This field is enabled only if you select Reconciliation using this information in the Print field.

Report orientation. Select Portrait for the report to appear vertically or Landscape for the report to appear
horizontally.

Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option is
provided.

Note: The heading defaults to Bank Reconciliation Report in the Title field. You can leave this as the title for
the report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how you want the heading aligned and whether
you want your organization’s name to appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

lE Mew Bank Reconciliation Report I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2 |

1: General |
Headings
Criteria 5
Detail — Heading Format
Sart Title: |Bank Recanciliation Report
Page Footer Subtite: |

Feport Footer
Miscellaneous Aligr: IEentel 'I

[¥ Print organization narne in header

W Print Page Number in Heading ¥ Print Report Date in Heading
Format: IF'age 1 j Format: I Short Date and Time j
Align: [Right =] | A JLet =]

¥ Print report heading on each page

< Back | L= Cancel Print Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.
lE Mew Bank Reconciliation Report I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2

1: General 2: Format |

‘B Criteria

Dietai [+ Print these criteria on Ia separate page "I

Sort Saved report name

Page Foater Eank account

Feport Foater Prirt

Miscellaneous Beginning balance
Reconcilistion date
Ending balatice

< Back | L= | Cancel | Print | Freview | Layout |

Detail. Use Detail to select details specific to the Bank Reconciliation Report. You can mark checkboxes to print

transaction details for reconciling the bank register and cash accounts to the statement. If you have the
optional module Projects and Grants and defined transaction codes, additional checkboxes appear.

lﬂ MHew Bank Reconciliation Report

File  Edit

Wiew Favorites

Toolz: Help

= = RE = e

1: General 2: Format |

Headings
Criteria

Sart

Page Footer
Report Footer
Miscellaneous

[V Print transaction details for reconciling the register to the statement

v Cleared deposits
W Cleared deposit adjustrments

W Cleared payments

[ Cleared payment adjustments
[ Dutstanding deposits

W Outstanding deposit adjustments
¥ Outstanding payments

i
| e Y "

[V Print tranzaction details for reconciling the cash accourt(s] ta statement

¥ Cleared posted

¥ Cleared not pet posted

W Cleared posted after statement ending date

W Outstanding posted

[+ Dutstanding not yet posted

[+ Outstanding posted after statement ending date

< Back | |t (=

FErint Preview

Cancel

Layaout
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Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by
column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column in the grid, the program sorts by the transaction number in
ascending order.

lg Mew Bank Reconciliation Report I
File Edt Yiew Faworites Toolz Help

B SR ] 2 |

1. General  2: Format |

Headings Sort

Criteria

Detail Sart by | Orderky |
B Sort Transaction number Azcending

Page Footer
Feport Footer
Miscellaneaus

< Back | [dErts Caticel Print Preview Lapout
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

n Mew Bank Reconciliation Report

File  Edt “iew Fawaortes Toolz Help
H &= 5w i

1: General 2: Format ]

2] Headings Page Footer

=] Criteria

5 Deta Page Footer Text

E| Sark Text:

=] Report Footer

2] Miscellaneous

[~ Frint Page Mumnber in Footer [ Frint Report Date in Footer

< Back | | Cancel Print | Freview | Layout |

Report Footer. You can enter a maximum of 254 characters in the report footer and select how you want text

aligned. The report

footer appears at the end of the report.

u New Bank Reconciliation Report

File Edit Wiew Favorites Tools Help
u _1 % —a mJ ? .
1: General 2 Format ]
21 Headings Report Footer
=] Criteria
5 Detail Report Footer Text
5] Sort Text:
=l Page Footer
2] Mizcellaneous
< Back | | Cancel Print Preview Layout
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the report and the font size
for the report.

lE MNew Bank Reconciliation Report [ x| I
Fil= Edit “iew Fawortes Tools Help

G E R0 =2 |

1: General  2: Format |

Headings Miscellaneous
Criteria

Detail Show curmency character on All amaounts
Sart Show percent sign an All amaounts
Page Footer MWegative amount format [1234.56]
: |-E': MNumber of digits after decimal for amounts 2
[ MNumber of digitz after decimal for percentages 2

Show 1000's zeparator Yes

Show blankz instead of zeros Mo

Font size a

Sample amaoLint:

Armnount [$1,234.5E]
Percent 100.00%
< Back | [Hexts Cancel Frrint Preview Layout

Bank Register Report

The Bank Register Report presents transactions in the register of a bank account. This report provides a summary
statement or can be filtered to display specific information. For example, you can filter the report to display only
outstanding deposits posted to Student Billing. In summary format, the report includes total deposits, total
payments, and grand totals. The amounts for each type of check are also listed.

The Bank Register Report has only two tabs on which you set parameters: General tab and Format tab. To move
among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs
you specify the records to include in the report and how the report should look. You can filter bank transactions
by clicking the Filters button found on the General tab. For more information about creating a Bank Register
Report, see “Creating a Cash Receipts report” on page 9.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize the output results of your report.

For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s
results.
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On the General tab, you set parameters specific to the report you have open and make selections about
information included in the report. The Bank Register Report does not have a Filters tab; you can filter bank
transactions for this report by clicking the Filters button found on the General tab.

n Mew Bank Register Report
File Edit “iew Favortez Toolz Help

H &S 5w Y=

l 2 Format ]

Feport format: Detail - Filters. .
Bank account: |Dpelating ﬂ Operating Account

Show transactions with these dates
Transaction date: |Include all dates ﬂ

|Landscape [

| Mewut » | Cancel | Prrint | Preview Layout

Report format. In the Report format field, select Detail or Summary.
Bank account. In the Bank account field, select the bank account to include in the report.

Show transactions with these dates. In the Transaction date field of the Show transactions with these
dates frame, select a specific date or date range for transactions to include in the report.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.
If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is

included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Report orientation. If you select to create the report in summary format, select Portrait for the report to
appear vertically or Landscape for the report to appear horizontally. If you select to create the report in detail
format, the Report orientation field is disabled and the orientation is set to Landscape.

Note: The filters function for the Bank Register Report differs from all other reports. Click the Filters button on
the General tab to filter bank transactions.
Filters button. The filters function for the Bank Register Report differs from all other reports. When you click

the Filters button, The Transaction Filters for Bank Name screen appears. Five filter options (General, System,
Transaction Type, Transaction Status, and Post Status) are found in a list on the left side of the screen.
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Filters Button

Note: The Filters button for the Bank Register Report is very similar to the Filters button found on the bank
register screen for a bank account.

When you click the Filters button, the General, System, Transaction Type, Transaction status, and Post Status
filter options appear. Click each filter option and a grid with corresponding filtering options appears.

General. Use the General option to establish date and amount ranges for payments and deposits.

In the From and To columns for the first two rows, Show deposits with these dates and Show payments with
these dates, enter beginning and ending dates, or click the fields to select dates from a calendar.

In the From and To columns for the second two rows, Show deposits with these amounts and Show
payments with these amounts, enter beginning and ending amounts, or click the fields to use a calculator to
calculate amounts.

Tranzaction Filters for BankMame

S_l,lstem

Tranzaction Type Show deposits with thesze dates
Transaction Status Show papments with these dates
Post Status

Show depozits with theze amounts

Show payments with theze amounts

Beset Filters to Show &l Transactions 0k I Cancel |

System. Use the System option to select which Blackbaud programs to include in the report.

i Trangsaction Filters for Operating Account

Gisneral System I Show? |

Transaction Type General Ledger [

Tranzaction Status Accounts Payable ™2

Post Status .
Accounts Receivable W
Student Billing W
Payrall 2
Fixed Azzetz v
Caszh Management rdl
Cazh Receipts W

Beszet Filters to Show All Transactions (]9 I Cancel
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Transaction Type. Use the Transaction Type option to select transaction types to include in the report. In the
Start Number and End Number columns, enter beginning and ending transaction numbers.

i Trangsaction Filters for Operating Account

General Tranzaction Tupe I Show?l Start Mumber | End Mumber I
: M anual Check ¥
Tranzaction Status Computer Check ™2
Post Status .
One-Time Check v
EFT Check 2
Bank Draft v
Deposit v
Adiustment-D eposit I
Adjuztment-Payment I
Adiustrment-Transfer in 2
Adiustrment-Transfer out v
Beszet Filters to Show All Transactions (]9 I Cancel

Transaction Status. Use the Transaction Type option to select which bank register transaction statuses to
include in the report. In the Start Date and End Date columns, enter beginning and ending dates, or click the
fields to select dates from a calendar.

% Transaction Filters for Operating Account

General Status I Show? | Start [1ate End Date
System .
Tranzaction T Outstanding I
ira ' t Cleared ™
o e Reconciled ™
Yaided ™

HReszet Filters ta Show All Tranzactions | (1] I Cancel |
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Post Status. Use the Post Status option to select post statuses to include in the report. In the Start Date and
End Date columns, enter beginning and ending dates, or click the fields to select dates from a calendar.

i Trangsaction Filters for Operating Account

ger'tueral Fozt Status I Show? I Start [ate | End Date
watem
Tranzaction Type it pet posted I

| Transaction Status Pasted ¥
: Do not post W

Beszet Filters to Showa‘-\llTransactiunsl (]9 I Cancel |

Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option is
provided.

Note: The heading defaults to Bank Register Report in the Title field. You can leave this as the title for the
report or enter your own.



BANK ACCOUNT REPORTS 43

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how you want the heading aligned and whether
you want your organization’s name to appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

Filz  Edit

lE Mew Bank Reqgister Report
Yiew Favartes

Tonlz Help

= D= R = 2

]|

1: General

Criteria

Detail
Sort/Break
Page Footer
Feport Footer
Miscellaneous
Color Scheme

— Heading Format
Title:

|Bank Register Report
Subtitle: I

Align: I Center - I

[¥ Print organization narne in header

W Print Page Number in Heading ¥ Print Report Date in Heading

Format: IF'age 1 j Format: I Short Date and Time j
Align: [Right =] | A JLet =]
¥ Print report heading on each page
< Back | L= Cancel Print Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print

with the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.

n Mew Bank Reqgister Report
File  Edt “iew Fawaortes Toolz Help

WS 5w PR

1: General 2: Format ]

B Headirgs Critena

Criteria

) Detal [v  Print these criteria on | a separate page A

E] Sart/Bresk v Saved repart name -
5] Page Foater w| Bank account to include o
Z] Report Footer w] Transaction dates to include

2] Miscellaneous | Deposit dates to include

] Colar Scheme w| Payment dates to include

w| Deposit amounts to include

w| Payment amounts to include

w| Blackbaud systems to include

w| Tranzaction types to include

w| b atwial check numbers to includs s
w| Computer check numbers to include

w| Ore-time check numbers ba include

w| Bank draft numbers to include

w| D eposit numbers to include

W] Sdjustment deposit numbers to include

v Adiustrient pasment numbers to include j

< Back | | Cancel | Print | Freview | Layout |

Detail. Use Detail to select details specific to the Bank Register Report. Mark the checkboxes to show distribution

by transaction characteristics. If you have the optional module Projects and Grants and defined transaction
codes, additional checkboxes appear.

n MNew Bank Register Report
Fil= Edit “iew Fawortes Tools Help
H (&= W L

1: General  2: Format ]

=] Headings Detail

2] Criteria
B Detai
=] Sort/Break,

2] Page Footer

2] Report Footer
=] Mizcellaneous
2] Color Scheme

[~ Show distribution for these characternistics

[
[ van

< Back Cancel Frrint Preview Layout
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?

for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Break Header frame, you can enter up to 30 characters of information in the Text before value and Text
after value fields to print directly before and after the value for the selected sorting category.

lﬂ New Bank Reagister Report E=
File Edit %“iew Favortes Tools Help

= D= RE = el

1: General 2 Format |

Headings Sort/Break
Criteria

Detail Sort by | Order by | Breakz |
g

i 24t Transaction number Azcending
Page Footer

Freport Footer
Miscellaneous
Color Scheme

o|oon|ig

Break Header for Transaction nurmber-

Text before value: |

Test after value: I

Break Footer for Transaction nurmber-

[ ittt count per Transachon number

™| Britt cournt a5 & percentage of batal

[™| Fage break ot each newi Tirars action Aumber

£ Back | st Cancel Frrirt Prewview Layout
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Page Footer. You can enter a maximum of 254 characters in the page footer. You can include other options, such
as the page number and date.

lE MNew Bank Register Report I
Fil= Edit “iew Fawortes Tools Help

G E R0 =2

1: General  2: Format |

Headings Page Footer

Criteria
Dietail — Page Footer Text
Sort/Break, Test:

‘B Page Footer
Fieport Footer
Miscellaneous

Color Scheme Aligr: I Center - I

I Print Page Mumber in Footer [~ Print Report Date in Footer
Format: IF'age 1 j Farmat: I Short Date and Time j
Align: IHight j Aligr: ILeft j
< Back | [Hexts | Cancel Frrint | Preview | Layout |

Report Footer. You can enter a maximum of 254 characters in the report footer and select how you want text
aligned. The report footer appears at the end of the report.

lg Mew Bank Reqgister Report I
File Edt Yiew Faworites Toolz Help

B SR ] 2

1. General  2: Format |

Headings Report Footer

Criteria
Detail Report Footer Test
Sort/Break Tent:
Page Footer

‘B Feport Footer
Miscellaneous

Calar Scheme Sligr: I Center o’ I

< Back | [dErts Caticel Print Preview Lapout
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the report and the font size

for the report.

n MNew Bank Register Report
Fil= Edit “iew Fawortes Tools Help
H (&= W L
1: General  2: Format ]
2] Headings Miscellaneous
] Criteria
5 Detail Show curmency character on All amaounts
=] Sart/Break Show percent sign on Al amounts
=l Eage F'D:Dte' MWegative amount format [1234.56]
—Lfieport bonter MNumber of digits after decimal for amounts 2
ellaneous = :
5 Color Scheme MNumber of digitz after decimal for percentages 2
Show 1000's zeparator Yes
Show blankz instead of zeros Mo
Font size a
Sample amount;
Arnount [$1.234.5E]
Percent 100.00%
< Back | | Cancel | Frrint | Preview | Layout |

Color scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

u New Bank Register Report
File Edit Wiew Favorites Tools Help

H &2 @& ?-

1: General 2 Format ]

=] Headings
=] Criteria

2] Detail v
2] Sort/Break

2] Page Footer

2] Report Footer

2] Mizcellaneous

M Column heading back colar
| Column heading fore color

[ Group heading back color

M Gioup heading fore color

Restore Defaults |

Color Scheme

Report Name
Subtitle

Column Headings

Group Headings

< Back | | Cancel

Print Preview Layout
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Custom Reports make it easy for you to access and share reports you create using Crystal Reports. Using Custom
Reports, you can link a Crystal report file with a Cash Receipts export file and then save the linked report in your
Financial Edge database. Once the files are linked, you and other Financial Edge users can easily view or print
custom Crystal reports directly from Cash Receipts without having to open Crystal Reports.

The Financial Edge includes one license for Crystal Reports XI. Clients creating custom reports using Export in
The Financial Edge with Crystal Reports will need a license for each person creating custom reports. In addition,
each license is associated with a particular product, which means if one person is reporting for both The Financial
Edge and The Raiser’s Edge, that individual needs two Crystal Reports Xl licenses. For information about
purchasing additional Crystal Reports Xl licenses, send an email request to solutions@blackbaud.com or contact
your account representative.

Creating Custom Reports

When setting up the Crystal report and the export file, it is important to remember that you can add as many or
as few fields as you want to the Crystal report as long as those fields are also contained in the export file. You can
add additional fields to the export file that are not included in the Crystal report, but you cannot add fields to the
Crystal report that are not included in the export file.

Make sure to format the export file in one of these *.MDB formats: Blackbaud Report Writer Database, Microsoft
Access 2.x Database, Microsoft Access 95 Database, Microsoft Access 97 Database, or Microsoft Access 2000
Database. For more information about creating export files, see the Export Guide. For more information about
creating Crystal reports, see the Crystal Reports help file.

» Creating a custom report
1. From the Cash Receipts Reports page, click Custom Reports. The Custom Reports page appears.

# The Financial Edge

File Edit Yiew Go Favoites Took: Help

4 Back  # Eanians ] Community Services Inc. ™ « Cash Receipts ~

12 Reports + Custom Reports

New ‘Dpen |Qelels Reports

T Bark
B Custom Repart Custom Repoﬁ Account

Reports

| Mame ‘ Descmptionl [rate Created | Created Byl Others May b... | Others i
i Supervisor - Reports
ay. 0

Deposit and
Receipt
Reports

Fivol
Reports
Transaction
Reports

Shartcuts

i 1|

e a il [~ Only show my reports

Maonthly Reports
Web Links

‘Welcome to Cash Receipts |

from export data. Just ink the Crystal report file with an export to store it in the
database and make it available to all users.

n The Custom Repoart pravides an easy way to share Crystal reparts pou create
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2. Click New. The Custom Report screen appears.

I3 Mew Custom Report I
File Edit “iew Favortes Tools Help

BRE R0 =2 |

1: General I

Select Export: I ﬁl%l

Select Cryztal Report: I _I

¥ Refresh Export

< Blanhk | et | Catcel | Print | Praview | Layaout |

3. Inthe Select Export field, click the binoculars to locate the export file you want to use as a data source for
your custom report. The Open screen appears.

Flopen @
Find: | Export 7| Search using query: [< Defauls [

= | Dz 1i Add a Mew Export Optionz

Export bype: I j Last modified by: I j
Export format: I j Lazt modified or: Iany time j
Export name: I j
Description: I j

Hide Filters | Clear Filtersl Previous Filtersl Filters are not applied Find Mow I [Hper Cancel

|F'less F7 to zoom

Note: Only exports in saved in a Microsoft Access database file format (*.MDB) appear on the Open screen.

4. From this screen you can select an existing export file or create a new export file.

¢ To select a file, select the file name and click Open. You return to the Custom Report screen and the
selected export file name appears in the Select Export field.
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Note: Make sure to format the export file in one of these *.MDB formats: Blackbaud Report Writer Database,
Microsoft Access 2.x Database, Microsoft Access 95 Database, Microsoft Access 97 Database, or Microsoft
Access 2000 Database.

¢ To create a new export file, click Add New. The Create a New Export screen appears where you can
create an export file to use with Custom Reports. After you create and save your export file, you return
to the Custom Report screen and the selected export file name appears in the Select Export field. For
more information about creating export files, see the Export Guide.

5. Inthe Select Crystal Report field, browse to the Crystal report file you want to link to the selected export
file. The Open screen appears.

6. Select the Crystal report and click Open. You return to the Custom Report screen and the selected report
name appears in the Select Crystal Report field.

u Mew Custom Report
Eile Edit “iew Favortez Tools Help
EH &= W ¥
1: General ]
Select Export: |F'a_|,.|ments Q@l
Select Crystal Report: |Payments.rpt J

v FRefresh Export

| | Cancel | Print | Freview | Layout |

Note: If you selected the Save Data with Report option when you created the Crystal report, this option has
no effect when the report is run from The Financial Edge — the program simply ignores it. If you want to make

the custom report “static” (the data does not update each time the report is run) you should unmark the
Refresh Export option.

7. To automatically refresh the export file every time you view the report, mark Refresh Export. If you do not
mark this checkbox, when you run the report the program checks to see if the export file is saved on your
machine. If it is, the program uses the existing export file and will not update the data each time you run
the report. If the export file is not saved to your machine, the program generates a new export file and
includes current data from the database.
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11.

12.
13.

Click Preview to view a copy of the report on your screen before printing.

I3 New Custom Report HEE

x| 4 4 Tai Y oe | & & F& ox Z][ [ [#h Toaiz oz 1eaie

Preview

Fayrnent added by Payrnent Armaunt Deposit number
Supervisor § 76.00
Superisor § 75.00
Supervisor § 7500
Supervisor §125.00
Supervisor § 47.00
Superisar § 1300
Supersisor § 25.00
Supervisor § 200.00
Supervisor § 21000
Supervigor § 8563
Supervisor F125.00
Supervisor § 9e.00

D L) LD LD R R R

oo ool

L
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A copy of the report appears on your screen. If the report is okay, click the Print button at the top of the

preview screen to print the report.

To save the report parameter file, click File, Save from the menu bar. The Save report as screen appears.

Save Report as E I
Repart name: I
Description:

v Others can un this report
[~ Others can modify this report

[Hisave | Cancel |

Enter a Report name and a Description. You can also mark options to allow other users to run or modify

this report.
Click Save. You return to the Custom Reports screen.
To return to the Reports page, select File, Close from the menu bar.

Editing an Export for a Custom Report

Warning: You cannot delete fields from an export file if the export is linked with a Custom Report. The
Remove button is disabled in Export. You also cannot delete an export file linked with a Custom Report. If you
try, an error message appears.

You can edit an export file directly from the Custom Reports screen by clicking the Click to edit export button.
You can add additional fields to the export file that are not included in the Crystal report, but you cannot add
fields to the Crystal report that are not included in the export file. Each time you run a saved Custom Report,
The Financial Edge checks to make sure the fields selected for the Crystal report are still included in the export

file.
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» Editing an export file from an open Custom Report

1. Open the saved Custom Report you want to edit. The report opens displaying the General tab.

I Movember Payments I
File Edit “iew Favortes Tools Help

B2 & @2 |

1: General I

Select Expart: IF'a_l,Jments @

Select Crystal Report: IPa_l,Jments.rpt _I

¥ Fiefresh Export

< Bachk | fest> | Cancel |

Erint | Previeﬂl Lapout |

2. Inthe Select Export field, click the Click to edit export button next to the binoculars. The export file
appears, displaying the Filters tab.

E. Payments Hi=] E3 I
File Edit “iew Favortes Toolz Help

E]SaveandClosev| = X||3 B.|

1: Filkers: |g; Dutputl

&0 0pen 7 Clear All Filters
Filters I Include Selected Filkers
Payments all <All Payments =
Payment Attributes all <Al Payment attributes=
Payment for all <Al Payment for=
Banks all <Al Banks >
Deposits all <All Deposits =

4 Back | Mest » | Cancell EHDDItNDﬂl

| | 7

3. Make any necessary changes on the Filters and Output tabs, and click Save and Close. You return to the
Custom Report screen.

4. Click Print to print the report or save and close the updated report.
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Reporting categories in Cash Receipts include Bank Account Reports, Deposit and Receipt Reports, Pivot Reports,
and Transaction Reports. This chapter discusses Deposit and Receipt Reports. For information about other report
categories, see the chapter for that category.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about deposit and receipt reports in Cash Receipts. Hands-on
experience is the best way to learn, so we encourage you to try various options with your sample database.

Deposit and Receipt Reports in Cash Receipts include:

e Cash Receipts Report

e Deposit List

e Deposit Report

Cash Receipts Report

The Cash Receipts Report lists detailed cash receipts activity over a specified period of time. This report is the
only report in Cash Receipts that shows individual receipts and payment detail.

The Cash Receipts Report has three tabs on which you set parameters: General tab, Filters tab, and Format tab.
To move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On
these tabs you specify the records to include in the report and how the report should look. For more information
about creating a Cash Receipts Report, see “Creating a Cash Receipts report” on page 9.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize the output results of your report.
For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s
results.



DEPOSIT AND RECEIPT REPORTS 59

On the General tab, you set parameters specific to the report you have open and make selections about the
information included in the report.

lﬂ Hew Cash Receipts Report I
Fil= Edit “iew Favartes Toolz Help

2SR w2 |

| 2 Filtersl 3 Format I

Include tranzactions with these dates

D eposit date: IIncIude all dates j
Receipt date: IIncIude all dates j
Entered on date: Ilnclude all dates j

Include deposit numbers from: | | To |
Ihciude receipt numbers from: I ﬂl T I

Edld

[~ Show miscellaneous payment details
Ihclude deposits fram

¥ Accounts Beceivable
_|¥ Cash Receipts

[~ Create an output guery of IDepnsits 'I
R eport orientation; IPortrait - I

< Hiack | MHewt » | Cancel | Prrint | Preview | Layout |

Deposit date. In the Deposit Date field, select a date or date range for deposit dates to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Receipt date. In the Receipt Date field, select a date or date range for receipts dates to include in the report. If
you want to include all the receipts in a deposit, you do not need to enter a receipt date.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Entered on date. In the Entered on date field, select a date or date range for which deposits were entered into
the program.

Include deposit numbers from [] to [ ]. In the Include deposit numbers from [ ] to [ ] field, enter or select a
range of deposit numbers to include in the report. If you leave both fields blank, the report includes all
deposit numbers.

Include receipt numbers from [ ] to [ ]. In the Include receipt numbers from [ ] to [ ] field, enter or select a
range of receipt numbers to include in the report. If you leave both fields blank, the report includes all receipt
numbers.

Show miscellaneous payment details. Mark this checkbox to separate payments into separate lines for
Accounts Receivable and Cash Receipts. This option appears only if you have Accounts Receivable installed.

Include deposits from [ ]. Mark the checkbox for each program whose deposits you want to include in the
report. The options appearing depend on the programs you have installed (Accounts Receivable, Cash
Receipts, or Student Billing).

Create an output query of deposits. Mark this option to create a query of deposits that appear in the
report. This query is available for use in other areas of the program.
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Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

Report orientation. Select Portrait for the report to appear vertically or Landscape for the report to appear
horizontally.

Filters Tab

On the Filters tab, you can filter the information appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

I@ Hew Cash Receipts Report I
Fil=e Edit “iew Favortes Toolz Help
== e |

1 General § | 3 Format |

f®0pen ) Clear Al Filters

Filkars I Include Selected Filkers

Clignts all <Al Clients=

Client Atkributes all <All Client Attributes>

Barks all <All Banks >

Deposits all <Al Deposits =

Pavments all <Al Payments =

< Back Hemt » Cancel Print Preview Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Funds filter, only transactions in the selected funds appear in the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, each filter in the Include column is set to All. To open a selection screen to designate specific
filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Deposits Ed I

Include: & All O Selected ® Range ® Query | Erzsions Filizr Meut Filter

Deposit | Description |

Ok I Cancel |

Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may
also be able to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. Previous
Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Cash Receipts Report in the Title field. You can leave this as the title for the
report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how you want the heading aligned and whether
you want your organization’s name to appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print

with the report.



DEPOSIT AND RECEIPT REPORTS 63

Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of

the report.
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Detail. Use Detail to select details specific to the Cash Receipts Report. To show distribution by account and
project characteristics, mark Show distribution for these characteristics and the checkboxes for the
characteristics. If you select only one characteristic, you can mark Show characteristics as a column in the
main report body to show a single characteristic as a separate column in the report. This creates a shorter
report because all information for the characteristic appears as an extra column rather than as an additional

subreport.

You can also mark Show transaction total to display the total amount of the transaction in addition to the
distribution amounts and Show receivables/balancing account distribution to show receivables information

for a distribution.
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To add additional summary reports to the end of the main report, mark Include summary report for and mark
the checkboxes for each item on which to report.
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Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and defined transaction codes, additional checkboxes appear. You can use the Up
and Down buttons to order the characteristics to appear on the report.
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting

category. For example, you can sort and break by Deposit Number. This prints information about each deposit
on a new page.

In the Break Header frame, you can enter up to 30 characters of information in the Text before value and Text
after value fields to print directly before and after the value for the selected sorting category.

In the Break Footer frame, you can mark Print count per or Print count as a percentage of total for the
number or percentage for the selected sorting category to appear in the footer. If you want a new page for the
selected sorting category, mark Page break on each new <sort category>.
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.
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Report Footer. Use Report Footer to create a footer to appear at the end of the the report’s data. You can enter
a maximum of 254 characters in the Text field for the report footer and select how to align the text.
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the report and the font size

for the report.
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.
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Deposit List

The Deposit List displays summarized information about a selection of deposits, including the projected deposit
total and the actual deposit total. This report can be used for a quick comparison to a bank account record or
bank statement.

The Deposit List has three tabs on which you set parameters: General tab, Filters tab, and Format tab. To move
among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs
you specify the records to include in the report and how the report should look. For more information about
creating a Deposit List, see “Creating a Cash Receipts report” on page 9.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize the output results of your report.
For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s
results.

On the General tab, you set parameters specific to the report you have open and make selections about the
information included in the report.
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Deposit date. In the Deposit Date field, select a date or date range for transaction dates to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Entered on date. In the Entered on date field, select a date or date range for which deposits were entered into
the program.
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Post date. In the Post Date field, select a date or date range for post dates to include in the report.

Include deposit numbers from [] to [ ]. In the Include deposit numbers from [ ] to [ ] field, enter or select a
range of deposit numbers to include in the report. If you leave both fields blank, the report includes all
deposit numbers.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

Only include deposits whose amounts are greater than [ ]. Mark this option to enter the minimum
deposit amount to include in the report.

Include deposits from [ ]. Mark the checkbox for each program whose deposits you want to include in the
report. The options appearing depend on the programs you have installed (Accounts Receivable, Cash
Receipts, or Student Billing).

Create an output query of deposits. Mark this option to create a query of deposits that appear in the
report. This query is available for use in other areas of the program.

Report orientation. Select Portrait for the report to appear vertically or Landscape for the report to appear
horizontally.

Filters Tab

On the Filters tab, you can filter the information appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.
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Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Funds filter, only transactions in the selected funds appear in the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, each filter in the Include column is set to All. To open a selection screen to designate specific
filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Deposits I

Include: & Al o Selected ® Range ® Guery Pz Filizr Mext Filter

Deposit | Description |

Ok I Cancel

Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may
also be able to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. Previous
Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.
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Note: The heading defaults to Deposit List in the Title field. You can leave this as the title for the report or
enter your own.

Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how you want the heading aligned and whether
you want your organization’s name to appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print
with the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.
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Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by
column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column in the grid, the program sorts by deposit number in ascending
order.
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Mark Page break on each new <Sort by selection> to start a new page for each Sort by selection.

u New Deposit List
File Edit Wiew Favorites Tools Help
u _1 % —a mJ ? .
1 Genelal] 2 Filterz  3: Format l
=] Headings Sort
=] Criteria
Sort by | Order by |
=] Page Footer Deposit Humber Ascending
2] Report Footer
=] Miscellaneous
=] Colar Scheme
" Page break on each new Depasit Mumber
< Back | | Cancel Print | Preview | Layout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the

text and include the page number and date in the footer.
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Report Footer. You can enter a maximum of 254 characters in the report footer and select how you want text
aligned. The report footer appears at the end of the report.
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the report and the font size

for the report.

n Mew Deposit List
File Edt Yiew Faworites Toolz Help
u _5- é —a mJ ? -
1: General ] 2 Fiters 3 Format l
2] Headings Miscellaneous
2] Criteria
=] Sort Shaw cunency character on All amounts
2] Page Footer Show percent sign on &l amaounts
=| HDD“ Footer Megative amaunt farmat [1234.56)
W - .
) Color Seheme Murnber of d?gfts after dECfI‘nEﬂ far arnounts 2
Murmber of digits after decimal for percentages 2
Show 1000 separator ez
Show blanks instead of zeros Mo
Fant gize 8
Sample amount:
Amaurt [$1.234.5E)
Percent 100.00%
< Back | | Cancel Brint Freview Lapout




DEPOSIT AND RECEIPT REPORTS 75

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to

the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

M@ New Deposit List I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2 |

1 Generall 2 Filters ~ 3: Farmat |

Headings Color Scheme

Criteria ;

Sort ; 03 Report Name
Ezgpzr't:?ot:l;r W Colurin heading back calar Subtitle
Miscellaneous [ Column heading fore colar Column Headings

[T Group heading back calar Group Headings

. Group heading fore color

Festore Defaults |

< Back | L= Cancel Print Freview Layout

Deposit Report

Note: You can also print deposit reports using the Print deposit tickets link in Deposit tasks. For more
information about Deposit tasks, see the Banks Guide.

The Deposit Report includes information about a selection of deposits, including a summarized breakdown of
payments types and banking information such as the account number and routing number. You can format this
report to use as a deposit ticket. Contact your bank to find what information is required for deposit tickets.

The Deposit Report has three tabs on which you set parameters: General tab, Filters tab, and Format tab. To
move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these
tabs you specify the records to include in the report and how the report should look. For more information about
creating a Deposit Report, see “Creating a Cash Receipts report” on page 9.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the

appearance of the report’s output. By specifying parameters, you customize the output results of your report.

For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s
results.
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On the General tab, you set parameters specific to the report you have open and make selections about the
information included in the report.
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Deposit date. In the Deposit Date field, select a date or date range for deposit dates to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Entered on date. In the Entered on date field, select a date or date range for which deposits were entered into
the program.

Post date. In the Post Date field, select a date or date range for post dates to include in the report.

Include deposit numbers from [] to [ ]. In the Include deposit numbers from [ ] to [ ] field, enter or select a
range of deposit numbers to include in the report. If you leave both fields blank, the report includes all
deposit numbers.

Only include deposits whose amounts are greater than [ ]. Mark this option to enter the minimum
deposit amount to include in the report.

Update the deposit printed on date when printing? Mark this option to update the deposit ticket print
date for each deposit included in the report.

Close deposit after printing? Mark this option to change the deposit status to closed for each deposit
included in the report run.

Include deposits from. Mark the checkbox for each program whose deposits you want to include in the
report. The options appearing depend on the programs you have installed (Accounts Receivable, Cash
Receipts, or Student Billing).

Create an output query of deposits. Mark this option to create a query of deposits that appear in the
report. This query is available for use in other areas of the program.



DEPOSIT AND RECEIPT REPORTS 77

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

Report orientation. Select Portrait for the report to appear vertically or Landscape for the report to appear
horizontally.

Filters Tab

On the Filters tab, you can filter the information appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Funds filter, only transactions in the selected funds appear in the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, each filter in the Include column is set to All. To open a selection screen to designate specific
filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.
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Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may
also be able to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen.Previous
Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.

Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Deposit Report in the Title field. You can leave this as the title for the report or
enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how you want the heading aligned and whether
you want your organization’s name to appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print

with the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.
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Report Footer Diepasit dates to include
Miscellaneous Entered on dates to include
Color Scheme Post dates to include

Include deposit number range
Include depost amounts
Include deposits from these systems

< Back | L= Cancel Print Freview Layout
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Detail. Use Detail to select details specific to the Deposit Report. Mark the checkboxes to show payment detail
by payment method. For example, if you mark Credit Card and leave all other checkboxes unmarked, the
report shows detail for only credit card transactions in each deposit. Mark Separate page for each payment
method to show payment information for each selected payment method on its own page.

M@ Hew Deposit Report I
File  Edt “iew Fawaortes Toolz Help
FlER = |
1 Generall 2 Filters ~ 3: Farmat |
Headings Detail
Criteria
B Detail W Show payment detail for these payment rmethods
Sort ¥ Check
Page Footer
Feport Footer [ Cash
; [¥ Credit card
Miscellaneous
Color Scheme [ COD
[+ Received EFT
¥ Other u |
P
Doty |
[" Seperate page for each payment method
< Back | L= | Cancel | Print | Freview | Layout |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid displays the categories you can sort in the report. Select a sorting category in the Sort by

column and select Ascending or Descending in the Order by column.
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If you make no selections in the Sort by column in the grid, the program sorts by deposit number in ascending
order.

1@ New Deposit Report
Fil= Edit “iew Fawortes Tools Help

EH <=2 -

1 Genelal] 2: Filters ~ 3: Farmat l

=] Headings Sort
] Criteria

=) Detal Sort by | Oderby |
Tranzaction Mumber

Azcending
2] Page Footer

2] Report Footer
=] Mizcellaneous
2] Color Scheme

< Back | Cancel Frrint | Preview | Layout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

u New Deposit Report
File Edit Wiew Favorites Tools Help
u _1 % —a mJ ? .
1 Genelal] 2 Filterz  3: Format l
=] Headings Sort
=] Criteria
=] Detail Saort by | Order by |
M Tranzaction Mumber Azcending
2] Page Footer

2] Report Footer
2] Mizcellaneous
2] Colar Scheme

< Back | | Cancel Print Preview Layout
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Report Footer. You can enter a maximum of 254 characters in the report footer and select how you want text

aligned. The report footer appears at the end of the report.

n MNew Deposit Report
Fil= Edit “iew Fawortes Tools Help

EH <=2 -

1 Genelal] 2: Filters ~ 3: Farmat l

5] Headings Report Footer

] Criteria

5 Detal Fieport Footer T ext

=] Sort Texst:

=l FPage Footer

=] Mizcellaneous

2] Color Scheme ’—_l

< Back | | Cancel | Frrint | Preview | Layout |

Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the report and the font size

for the report.

n Mew Deposzit Report
File Edt Yiew Faworites Toolz Help
u _5- é —a mJ ? -
1 General] 2 Fiters 3 Format l
2] Headings Miscellaneous
2] Criteria
=] Detail Shaw cunency character on All amounts
=] Sart Show percent sign on &l amaounts
=i Eage F'c:uoter Megative amaunt farmat [1234.56)
= eportoter Wurnber of digits after decimal for amounts 2
sCellaneols
5 Colar Scheme Murmber of digits after decimal for percentages 2
Show 1000 separator ez
Show blanks instead of zeros Mo
Fant gize 8
Sample amount:
Amaurt [$1.234.5E)
Percent 100.00%
< Back | | Cancel Brint Freview Lapout
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

M@ Hew Deposit Report I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2 |

1 Generall 2 Filters ~ 3: Farmat |

Headings Color Scheme

Criteria
Detail Report Name

gz;e Eocter W Colurin heading back calar Subtitle

Feport Footer [~ Columin heading fare calar Column Headings

Miscellaneous [T Group heading back calar Group Headings

. Group heading fore color

Festore Defaults |

< Back | L= Cancel Print Freview Layout
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Reporting categories in Cash Receipts include Bank Account Reports, Deposit and Receipt Reports, Pivot Reports,
and Transaction Reports. This chapter discusses Transaction Reports. For information about other report
categories, see the chapter for that category.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about transaction reports in Cash Receipts. Hands-on experience is
the best way to learn, so we encourage you to try various options with your sample database.

Transaction Reports in Cash Receipts include:
¢ Account Distribution Report
¢ Project Distribution Report

Account Distribution Report

The Account Distribution Report lists debit and credit amounts for General Ledger accounts created by Cash
Receipts transactions and their adjustments.

The detail report lists all transactions and associated debits and credits by account number. The summary report
shows the total debits and credits associated with each account. Adjustment transactions and miscellaneous
entries can also be included to further facilitate the reconciliation process.

The Account Distribution Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a Cash Receipts report” on page 9.
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General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

1@ Hew Account Distribution Report
Fil=e Edit “iew Favortes Toolz Help

H &= & ?-

l 2 Filtersl 3 Format ]

Repart format: |Detail ﬂ
Include transactions with these dates
Tranzaction date: |Include all dates ﬂ
Past date: |Include all dates ﬂ

[ Include adjustment transactions
W Inchude mizcellaneous entries

[~ Create an output query of

| Hemt » | Cancel Print Preview Layout

Report format. In the Report format field, select Summary or Detail. The detail report lists all transactions and
associated debits and credits by account number. The summary report shows the total debits and credits
associated with each account.

Transaction date. In the Transaction date field, select a date range for transactions to include in the report.

If you select <Specific range>, you can specify a start date and an end date. If the Start date field is blank, all
activity is included up to the end date. If the End date field is blank, all activity from the start date until
present is included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date range for the post dates of transactions to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include adjustment transactions. Mark this checkbox to include original transactions and their adjusting
transactions in the report.

Include miscellaneous entries. Mark this checkbox to include miscellaneous entries in the report. A
miscellaneous entry is a one-time adjustment you use in lieu of negative cash amounts.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

Create an output query of [ ]. Mark Create an output query of, to create a query of accounts or payments
that appear in the report. You can use the query later in other areas of Cash Receipts.
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Report orientation. If you select to create the report in summary format, you can select Portrait for the report
to appear vertically or Landscape for the report to appear horizontally. If you select to create the report in
detail format, the Report Orientation field is disabled and the orientation is set to Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Funds filter, only transactions in the selected funds appear in the report.

On the Filters tab, you can filter the transactions appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

lﬂ Hew Account Digtribution Report I
Fil= Edit “iew Favartes Toolz Help
W& R -2 |

1. General | 3 Format I

#@0pen 7 Clear All Filkers

Filters I Include Selected Filkers

Accounts all <All Accounts

Funds all <Al Funds =

Department(s) all <Al Department(s) =

Mlissionis) all <Al Mission{s) =

Spendable/Mon-Spendableds) Al <Al SpendablefMon-Spendableds) =

Performanceds) all <All Performancels)=

Classes all <Al Classes >

Projects all <Al Projects=

Account Attributes all <All Account Attributes >

Project Attributes all <all Project Attributes=

Deposits all <Al Depasits =

Pavments all <8l Payments =

Posk Statuses all <All Post Statuses>

< Back MHewt » Cancel Prrint Preview Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, each filter is set to All in the Include column. To open a selection screen to designate specific
filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Payments E

Include: o Al . ;! @ Range Erevious Filker — Bexst Filter

Payment I Descripkion I

QK I Cancel |

Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may
also be able to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option is
provided.

Note: The heading defaults to Account Distribution Report in the Title field. You can leave this as the title for
your report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how you want the heading aligned and whether
you want your organization’s name to appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

Filz  Edit

lE Mew Account Distnibution Report
Yiew Favartes

Tonlz Help

= D= R = 2

]|

1: General | 2 Filkers

E Heading:
Criteria

Detail

Grand Totals
Sort/Bresk
Page Footer
Report Footer
Miscellanenus
Color Scheme

— Heading Format

Title: |A-:c:nunt Diigtribution R epart
Subtitle: I

Align: I Center - I

[¥ Print organization narne in header

W Print Page Number in Heading ¥ Print Report Date in Heading

Format: IF'age 1 j Format: I Short Date and Time j
Align: [Right =] | A JLet =]
¥ Print report heading on each page
< Back | L= Cancel Print Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print

with the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.

lE Mew Account Distnibution Report
File  Edt “iew Fawaortes Toolz Help

= D= R = 2

]|

1 Generall 2 Filters ~ 3: Farmat |

Page Footer

Report Footer
Miscellanenus
Color Scheme

Tranzaction dates to include
Post dates to include

Include adjustments

Include mizcellaneous entries
Accounts to include

Funds to include
Diepartment(z] to include
Mizsion(z] to include
SpendableMon-5pendables] to include
Performance|z] to include
Claszes to include

Projects to include

Account attributes to include
Project attributes to include

‘B Criteria

Detai [+ Print these criteria on Ia separate page "I

Girand Totals Saved report name =]
Sort/Brask Output query name

[

< Back | L= | Cancel |

Print | F'leviegl Layout |

Detail. Use Detail to select details specific to the Account Distribution Report. To show distribution by
transaction characteristics, mark Show distribution for these characteristics and the checkboxes for the
characteristics. If you select only one characteristic, you can mark Show characteristics as a column in the
main report body to show a single characteristic as a separate column in the report. This creates a shorter
report because all information for the characteristic appears as an extra column rather than as an additional

subreport.
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You can also mark Show transaction total to display the total amount of the transaction in addition to the
distribution amounts.

n New Account Distribution Report

File  Edit

Wiew Faworites

Tools

Help

EH <=2

=] Miscellaneous

] Criteria

¥ Show distnbubion for these charactenstics
2] Grand Tatals [ Project ID

] Soit/Break [ Project Description

=] Page Footer [ Clasz

=] Report Footer [ Misgion

2 -

H

1 Genelal] 2: Filters ~ 3: Farmat l

™ SpendableMon-Spendable

] Colar Scheme " Performance e
Do
-
[~ Show trangaction tatal
< Back | | Cancel | Frrint | Preview | Layout |

Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and defined transaction codes, additional checkboxes appear.

n Mew Account Diztnibution Report

File Edt

View Favontes

Tools

Help

H &2 @w

=] Heading:
2] Criteria

] Detail

I Grand Totals

2] Sort/Break
2] Page Footer
2] Report Footer

o .

H

1 General] 2: Filkers ~ 3: Format l

Grand Totals

v Show grand totals for these charactenstics
[ Project ID
[ Project Description
[ Class
™ Mizzion

=] Mizcellaneous [ SpendableMon-Spendable U
] Color Scheme [ Performance 2
Dowr
< Back | | Caticel Print Preview Lapout
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?

for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Break Header frame, you can enter up to 30 characters of information in the Text before value and Text
after value fields to print directly before and after the value for the selected sorting category.

In the Break Footer frame, you can mark Print count per or Print count as a percentage of total for the
number or percentage for the selected sorting category to appear in the footer. If you want a new page for the
selected sorting category, mark Page break on each new <sort category>.

lE Mew Account Distnibution Report I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2 |

1: General | 2 Filters ~ 3: Farmat |
Headings Sort/Break
Criteria

Dietail Sort by | Order by | Break? |
Grand Totals Account MNumber Azcending

| reak,
Page Footer
Report Footer
Miscellanenus
Color Scheme

i i o o S

Break Header for dccount Humber-

Text before value; |

Teut after value: |

Break Footer for ccount Humber-

[~ Print count per Account Mumber
[~ Print count as a percentage of total

™ Page break on each new &ccount Number

< Back | L= Cancel Print Freview Layout
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

n Mew Account Distnibution Report
File  Edt “iew Fawaortes Toolz Help
H &= 5w i

1 General] 2 Filters ~ 3: Farmat l

5] Headings Page Footer

=] Criteria

5 Deta Page Footer Text

2] Grand Totals Tent:

5] Sort/Break.

Page Footer

] Report Footer

2] Miscellaneous ’—_|

=] Colar Scheme

[~ Frint Page Mumnber in Footer [ Frint Report Date in Footer
< Back | | Cancel Print | Freview | Layout |

Report Footer. Use Report Footer to create a footer to appear at the end of the the report’s data. You can enter
a maximum of 254 characters in the Text field for the report footer and select how to align the text.

u New Account Distribution Report

Fil=  Edit “iew Favortes Toolz Help
u _1 % —a mJ ? -
1 Genelal] 2 Filterz  3: Format l
21 Headings Report Footer
=] Criteria
5 Detail Report Footer Text
=] Grand Totals Text:
2] Sort/Break
=l FPage Footer
art Foagter
2] Mizcellaneous ’——|
2] Color Scheme
< Back | | Cancel

Print Preview Layout
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the report and the font size

for the report.

n New Account Distribution Report
Fil= Edit “iew Fawortes Tools Help
H (&= W L
1: General ] 2: Filters ~ 3: Farmat l
5] Headings Miscellaneous
] Criteria
5 Detail Show curmency character on All amaounts
=] Grand Totals Show percent sign on Al amounts
=l gorta’BFreak MWegative amount format [1234.56]
=] Page Foater MNumber of digits after decimal for amounts 2
=] Report Footer = :
T MNumber of digitz after decimal for percentages 2
5] Color Seherne Show 1000's zeparator Yes
Show blankz instead of zeros Mo
Font size a
Sample amount;
Arnount [$1.234.5E]
Percent 100.00%
< Back | | Cancel | Frrint | Preview | Layout |

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

File Edit “iew Favorites

H &2 @&

=] Headings

=] Criteria

=] Detail

=] Grand Tatals
2] Sort/Break
2] Page Footer
2] Report Footer
2] Mizcellaneous

u New Account Distribution Report

1 Genelal] 2 Filterz  3: Format l

Tools Help

3 -

®

Color Scheme

E Report Name
M Column heading back colar

Subtitle
[ Colurmn heading fore color Column Headings

[ Group heading back color Group Headings

M Gioup heading fore color

Restore Defaults |

< Back | |

Cancel Print Preview Layout
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Project Distribution Report

The Project Distribution Report lists debit and credit amounts for General Ledger projects created by Cash
Receipts transactions and their adjustments. You can print Project Distribution Reports only if you have the
optional module Projects and Grants.

The detail report lists all transactions and associated debits and credits by project. The summary report shows the
total debits and credits associated with each project. Adjustment transactions and miscellaneous entries can also
be included to further facilitate the reconciliation process.

The Project Distribution Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a Cash Receipts report” on page 9.

General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

IQ Hew Project Distribution Report I

File Edt “iew Favontes Toolz Help
SR E A= |

| 2 Fillersl 3 Formnat |

Feport format; IDetaiI j
Include tranzactions with theze dates -
Transachion date: IIncIude all dates j
Post date: IIncIude &l dates j

™ Include adjustment transactions
v Include miscellaneous enties

I- Create an output guery of IF'rniects 'I
R eport orientation: ILandscape 'I

< Hark | Heut » | Cancel | Print | Preview | Layout |

Report format. In the Report format field, select Summary or Detail. The detail report lists all transactions and
associated debits and credits by project. The summary report shows the total debits and credits associated
with each project.

Transaction date. In the Transaction date field, select a date range for transactions to include in the report.

If you select <Specific range>, you can specify a start date and an end date. If the Start date field is blank, all
activity is included up to the end date. If the End date field is blank, all activity from the start date until
present is included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date range for the post dates of transactions to include in the report.
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If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include adjustment transactions. Mark this checkbox to include original transactions and their adjusting
transactions in the report.

Include miscellaneous entries. Mark this checkbox to include miscellaneous entries in the report. A
miscellaneous entry is a one-time adjustment you use in lieu of negative cash amounts.

Create an output query of [ ]. Mark Create an output query of, to create a query of projects or payments that
appear in the report. You can use the query later in other areas of Cash Receipts.

Report orientation. If you select to create the report in summary format, you can select Portrait for the report
to appear vertically or Landscape for the report to appear horizontally. If you select to create the report in
detail format, the Report Orientation field is disabled and the orientation is set to Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Funds filter, only transactions in the selected funds appear in the report.

On the Filters tab, you can filter the transactions appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

IQ Hew Project Distribution Report I
File Edt “iew Favontes Toolz Help
ENENE RN |

1. General gFllle | 3 Format |

@ 0pen ) Clear Al Filters

Filkers I Include Selected Filters

Accounts all <All Accounts>

Funds all <Al Funds =

Department(s) all <Al Department(s) =

Mlisionis) all <Al Missions) =

spendable/Mon-3pendableds) al <Al SpendablefMon-3pendableis) =

Perfarmancels) all <8l Performancels) =

Classes all <hll Classes=>

Projects all <Al Projects=

Account Attributes all <All Account Attribubes =

Project attributes all <Al Project Aktribukes =

Deposits all <Al Deposits =

Pavments all <all Payments =

Post Statuses all <Al Post Statuses:

< Back | Heut » | Cancel | Print | Preview | Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
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Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, each filter in the Include column is set to All. To open a selection screen to designate specific
filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Include: @ Al O Selected @ Range Previous Filker — Mext Filter

Fayment I Descripkion |

ok I Cancel

Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may
also be able to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Format Tab

On the Format tab, you select how you want the report to appear. A description of each formatting option is
provided.

Note: The heading defaults to Project Distribution Report in the Title field. You can leave this as the title for
your report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in each of the Title and Subtitle fields. The title
and subtitle appear at the top of the report. You can select how you want the heading aligned and whether
you want your organization’s name to appear in the header. You can include the page number and date in the
heading. You can also select to include the heading on every page of the report.

Filz  Edit

lE Mew Project Distnibution Report
Yiew Favartes

Tonlz Help

= D= R = 2

]|

1: General | 2 Filkers

E Heading:
Criteria

Detail

Grand Totals
Sort/Bresk
Page Footer
Report Footer
Miscellanenus
Color Scheme

— Heading Format

Title: |Prc-ie-:t Distribution Report
Subtitle: I

Align: I Center - I

[¥ Print organization narne in header

W Print Page Number in Heading ¥ Print Report Date in Heading

Format: IF'age 1 j Format: I Short Date and Time j
Align: [Right =] | A JLet =]
¥ Print report heading on each page
< Back | L= Cancel Print Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print

with the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

lE Mew Project Distnibution Report I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2 |

1 Generall 2 Filters ~ 3: Farmat |

‘B Criteria

' Detai [+ Print these criteria on Ia separate page "I

Grand Totals

Saved report name -
Sot/Break Output query name I
Fage Footer Transaction dates to include
Report Footer Post dates to include
Miscellanenus Include adjustments
Colaor Scherne Include miscelaneous entries

Accounts to include

Funds to include

Diepartment(z] to include

Mizsion(z] to include

SpendableMon-5pendables] to include

Performance|z] to include

Claszes to include =
Projects to include

Account attributes to include

Project attributes to include ;I

< Back | L= | Cancel | Print | Freview | Layout |

Detail. Use Detail to select details specific to the Project Distribution Report. To show distribution by transaction
characteristics, mark Show distribution for these characteristics and the checkboxes for the characteristics. If
you select only one characteristic, you can mark Show characteristics as a column in the main report body to
show a single characteristic as a separate column in the report. This creates a shorter report because all
information for the characteristic appears as an extra column rather than as an additional subreport.
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You can also mark Show transaction total to display the total amount of the transaction in addition to the
distribution amounts.

u Hew Project Distribution Report

File Edit %“iew Favortes Tool: Help

H &S %W

?-

1 General] 2 Filters 3 Format ]

=] Headings
=] Criteria

Z] Grand Tatals
=] Sort/Break
=] Page Footer
=] Report Footer
Z] Mizcellaneous

Boes

vy distribution for these charactenstics

™ Account 1D

[T Account Description

[T Class

™ Mizzion

™ Spendable/Mon-5Spendable

Z] Color Scheme [ Performance LE
Do
-
[~ Show transaction total
< Back | | Cancel | FErint | Preview | Layaout |

Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and defined transaction codes, additional checkboxes appear.

File Edit “iew Faworites

n Mew Project Diztribution Report

Toole Help
? =

I Grand Totals

2] Sort/Break
2] Page Footer
2] Report Footer
=] Mizcellaneous
2] Colar Scheme

Grand Totals

H &S F W
1 General] 2: Filkers ~ 3: Format l
=] Heading:
2] Criteria
] Detail

v Show grand totals for these characteristics

[T Account 1D

[ Account Description

[ Class

™ Mission

[ Spendable/Mon-Spendable
[ Performance

Dot

< Back

Cancel

Erint

Freview Lapout
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?

for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Break Header frame, you can enter up to 30 characters of information in the Text before value and Text
after value fields to print directly before and after the value for the selected sorting category.

In the Break Footer frame, you can mark Print count per or Print count as a percentage of total for the
number or percentage for the selected sorting category to appear in the footer. If you want a new page for the
selected sorting category, mark Page break on each new <sort category>.

lE Mew Project Distnibution Report I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2 |

1: General | 2 Filters ~ 3: Farmat |
Headings Sort/Break
Criteria

Dietail Sort by | Order by | Break? |
Grand Totals Praject 1D Azcending

| reak,
Page Footer
Report Footer
Miscellanenus
Color Scheme

i i o o S

Break Header for Project 10

Text before value; |

Teut after value: |

Break Footer for Praject 1D -
[~ Print count per Praject [D

[~ Print count as a percentage of total

™ Page break on each new Project [

< Back | L= Cancel Print Freview Layout
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lE Mew Project Distnibution Report
File  Edt “iew Fawaortes Toolz Help

= D= R = 2

]|

1 Generall 2 Filters ~ 3: Farmat |

Headings
Criteria

— Page Footer Text

Page Footer

Detail

Grand Totals
Sort/Bresk
‘B Page Footer
Report Footer
Miscellanenus
Color Scheme

Text:

Aligr: I Center i I

I Print Page Number in Footer ———

[~ Print Repart Date in Footer

Format: IF'age 1 j Format: I Short Date and Time j
Align: | Right 2 5 [ =l
< Back | L= | Cancel | Print | Freview | Layout |
|

Report Footer. Use Report Footer to create a footer to appear at the end of the the report’s data. You can enter
a maximum of 254 characters in the Text field for the report footer and select how to align the text.

Ig New Project Distribution Report
File Edit Help

= D= R e 2

Wiew Fawvortes Tools

=]|

1 Genelall 2 Filterz  3: Format |

Headings
Criteria
Dretail

— Page Footer Tesxt

Page Footer

Grand Totals
Sort/Break.
‘B Page Footer
Fieport Footer
Miscelaneous
Color Scheme

Test:

Aligr: I Center I I

I Print Page Mumber in Footer

[~ Print Repart Date in Footer
Formnat: IF'age 1 j Farmat: I Short Date and Time j
Aligre | Fiight = | | A | Lot =l
< Back | et Cancel Print Preview Layout
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the report and the font size
for the report.

n New Project Distribution Report
Fil= Edit “iew Fawortes Tools Help

EH <=2 -

1 Genelal] 2: Filters ~ 3: Farmat l

5] Headings Miscellaneous

] Criteria
5 Detail Show curmency character on All amaounts
=] Grand Totals Show percent sign on Al amounts
5] Sort/Break MWegative amount format [1234.56]
j :Zﬂz[’:?‘j‘:t;l MNumber of digits after decimal for amounts 2
T MNumber of digitz after decimal for percentages 2
Z] Calor Scheme Show 1000's zeparator Yes

Show blankz instead of zeros Mo

Font size a

Sample amaoLint:

Armnount [$1,234.5E]
Percent 100.00%
< Back | | Cancel | Frrint | Preview | Layout |

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

u New Project Distribution Report
File Edit Wiew Favorites Tools Help

H &2 @& ?-

1 Genelal] 2 Filterz  3: Format l

=] Headings Color Scheme
=] Criteria N

] Detai I : Report Name

j g;‘?ﬂg;:fls M Column heading back colar Subtitle

2] Page Footsr | Column heading fore color
2] Report Foter [ Group heading back caolor Group Headings

2] Mizcellaneous

M Gioup heading fore color

Restore Defaults |

< Back | | Cancel Print Preview Layout
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